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1. Introduction 

What is GWR4? 

 

GWR4 is a new release of a Microsoft Windows-based application software for 

calibrating geographically weighted regression (GWR) models, which can be used 

to explore geographically varying relationships between dependent/response 

variables and independent/explanatory variables. A GWR model can be considered 

a type of regression model with geographically varying parameters. A conventional 

GWR is described by the equation 

 
k iikiiki xvuy  ,),( , 

where iy , ikx , , and i are, respectively, dependent variable, kth independent 

variable, and the Gaussian error at location i; ( ii vu , ) is the x-y coordinate of the ith 

location; and coefficients ),( iik vu  are varying conditionals on the location. Such 

modelling is likely to attain higher performance than traditional regression models, 

and reading the coefficients can lead to a new interpretation of the phenomena 

under study. An important extension of GWR is its semiparametric formation by 

mixing globally fixed and geographically varying coefficients.  

  
k il illikiiki zxvuy  ,,),(  . 

 

 

where ilz ,  is the lth independent variable with a fixed coefficient l . Such a model 

may reduce the model complexities and enhance its predictable performance. Using 

the framework of geographically weighted generalised linear modelling (GWGLM), 

logistic and Poisson regression models with geographically varying coefficients are 

also popular for binary or count data modelling. GWR4 enables the fitting of such 

GWR and GWGLM models with their semiparametric formations, associated 

statistical tests, and model selections by user-defined data and model settings. 

 

 

 

 

 

Local terms Global terms 
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Main features 

(1) Semiparametric GWR 

As noted above, a most remarkable feature of this release is the function to fit 

semiparametric GWR models, which allow you to mix globally fixed terms and 

locally varying terms of explanatory variables simultaneously. The function 

can be applied to popular types of generalized linear modelling including 

Gaussian, Poisson, and logistic regressions. Using the semiparametric 

modelling scheme, a new statistical test of geographical variability on 

geographically varying coefficients is enabled. It is also possible to use variable 

selection routines by which variables are automatically selected as either fixed 

or varying terms by recursive model comparisons.  

 

(2) Interface 

A tabbed interface has been introduced to enable modelling sessions to 

intuitively proceed in a step-by-step manner. Datasets and geographically 

listwise results can be viewed in separate spreadsheet-like windows. Several 

popular file types can be used as input data files (space, comma, tab separated 

text, and dbase IV formats). In addition, Areal key field can be integrated into 

the output of GWR modelling, enabling you to join your output CSV file to a 

GIS attribute table via the key field for mapping the result in a GIS 

environment. GWR4 can be also used by a batch mode without the Windows 

interface.  

 

(3) Requirements 

GWR4 runs on Windows Vista, Windows 7, 8 and 10 environments with 

the .NET Framework 4. The maximum size of data is dependent on your local 

machine environment. GWR4 dynamically allocates memory for large matrices 

(n by n, where n is the number of regression points) even for conventional GWR 

models. Thus using a PC having relatively large memory size (equal to or larger 

than 4GB) for running GWR4 is recommended. If the PC has multi-core 

processors, GWR4 automatically uses multi-threading routines to speed-up the 

computation. 
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Notes for use of GWR4 

 

(i) GWR4 is copyrighted by the GWR4 development team. 

(ii) GWR4 can be freely distributed and used for academic and non-profit 

purposes. The developers of GWR4 are not responsible for any 

difficulties that users of the software may encounter.  

(iii) When any results using GWR4 are published, the author(s) should 

clearly state that GWR4 was used. Recommended citations for the 

theoretical backgrounds of GWR4 modelling may be found in the 

References in this manual. 

2. Installation / Uninstallation 

 

< How to install GWR4 > 

Download the GWR4 installer, GWR4_setup.exe,  

and then double-click the icon.  

 

< .NET Framework and Visual C++ 2012/2015 Redistributable Package> 

GWR4 works only in Microsoft Windows environments that have the .NET 

Framework 4 and Microsoft Visual C++ Redistributable Package installed. If 

your PC does not have them installed, a message will pop up suggesting that 

you download the .Net Framework 4 Client Profile and the redistributable 

package from a Microsoft website, and automatically start setting up them if 

your PC is connected to the Internet. If your PC is off-line, obtain the stand 

alone installers of the .Net Framework Client Profile and the redistributable 

package which are available from from the Microsoft website download centre. 

 

< When the installer starts … > 

Follow the instructions to select the GWR4 installation folder and users. If the 

installation is successful, a shortcut to the program will appear on your desktop 

and in the GWR4 program group. You may access the program by clicking this 

shortcut. 

 

< To uninstall > 

To uninstall GWR4 from your local environment, you may use “uninstall 

GWR4” menu in the GWR4 program group. Alternatively, you can use the 

“Uninstall Programs” utility in the Control Panel group in Windows 

environments. 

GWR4_setup.exe 
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3. Starting the program, Exiting the program, and Tab design 

   < Starting the program > 

To start the program, double click the GWR4 shortcut icon on the 

desktop,  

or select it from the GWR4 program 

group.  

   < Tab design > 

Ensure that there are five tabs labelled Step 1 to Step 5. Click a tab label to 

move to the corresponding tab page. The first tab page when the program starts 

is “Step 1: Data>”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                

Figure 3.1: GWR4 startup screen 

 

< Exiting the program > 

To exit the program, select “Quit(Q)” on the File menu 

(alternatively, you can press the Alt and “F” keys 

simultaneously and then press the “Q” key), or you 

can click the close button in the top-right corner of the 

window.  

 

 

Tab labels 
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Five steps in GWR calibration 

 

We regard a session as the overall process by which settings are used to calibrate a 

GWR model. To build and proceed through your own session, you can generally 

follow the following five steps (Figure 4.1). Each step is separated into a tabbed 

page of the software. As described before, to move to a different page, click the 

corresponding tab label in the upper part of the window. 

 

 

 

Figure 3.2: Steps in a GWR modelling session with respect to the five tabs 

Step 5: Execute>

Execute the session to compare necessary 
calculations and read results.

Step 4: Output>

Specify filenames for the files storing the modelling 
results. 

Step 3: Kernel>

Choose a geographic kernel type and its bandwidth 
size. Automated optimisation of bandwidth size is 

also available.

Step2: Model>

Specify one regression type and the variable 
settings needed for GWR modelling.

Step1: Data>

Start your session by giving it a title then open 
your data file.
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4. Step 1: The Data Tab 

Data preparation 

 

< What fields do I have to prepare in my dataset? > 

To calibrate a GWR model, you must prepare a tabular dataset that contains fields 

of dependent and independent variables, and x-y coordinates. Every variable 

should consist of numeric values, except for Areal key, as an identifier of 

observation. Areal key is treated as a string field in GWR4. 

  

< Coordinates > 

Both projected and latitude/longitude (lat/lon) decimal degrees coordinates can be 

used as x-y coordinates in GWR4. However, projected coordinates are superior to 

decimal degrees in terms of computing time.  

 

< Possible data formats >  

GWR4 can open data files in text format delimited by space, comma, or tab; as well 

as files in dbase IV format (*.dbf). The most popular type is CSV (a text format that 

uses the comma delimiter).  

 

< dbase IV files > 

Since the shapefile spatial data format—a common GIS file format from ESRI 

Inc.—uses dbase IV as an attribute database linking with geographic objects, the 

function to read dbase file provides an easy way to use such a GIS data file in 

GWR4. However, there is one caveat for this function: 

 

In the case of dbase IV, the length of the filename must not exceed 8 characters, 

due to the restriction on database connection used in this software. Some examples 

of readable and unreadable filenames are shown below: 

 

Readable filenames:   tokyom.dbf, tokyodat.dbf 

Unreadable filenames:  dublindata.dbf, irelandmortality.dbf 

 

 

< Field names > 

In the case of text formats, the first line (row) of the data file must be the list of 

field names. (A dbase IV file automatically has the field name lists.) 
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< Samples of text-based data files > 

Two samples of data files using space and comma delimiters are shown below.  

 

Table 4.1: Sample of text data file for GWR4: Tokyo mortality data 

(Space delimited text file) 

 

 

 

 

 

 

 

 

  Note: only the first ten records are shown. 

 

 

Table 4.2: Sample of text data file for GWR4: Georgia data 

(Comma delimited text file: CSV) 

 

  Note: only the first twenty records are shown. 

 

 

< Missing values > 

GWR4 does not have functions for handling missing codes. Records having blank 

items in the dependent variable field are skipped for the model fitting. In the cases 

that there are blank items for independent variables, the model fitting fails. Avoid 

including missing values for your data set by excluding such data or estimated 

missing values before GWR modelling. 
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Operations in the data tab page 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

           Figure 4.1: Sample screenshot for “Step 1: Data” 

 

The following is the recommended procedure to follow on the “Data” tab page: 

(1) Create a session title that reflects your modelling intention and dataset. 

(2) Input the filename of your dataset in this textbox by clicking the rightmost 

“Browse” button to open a file dialog box.  

(3) Select the appropriate format or delimiter that separates each value in a 

row of a text data file. 

(4) Click the “Open” button. Both “Number of fields” and “Number of areas” will 

automatically appear. (Note: “Number of areas” refers to the number of data 

records/observations in the data file.)  

(5) You can view your dataset in a spreadsheet-like window by clicking the 

“View data” button. The number of rows (lines) in the gridded view can be 

controlled using the options to the left of the button (default is first 10 

lines).  

 

(1) 

(2) 

(3) 

(4) 

(5) 
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     Figure 4.2: Data view window 

5. Step 2: The Model Tab 

 

If the data file you specified on the “Data” tab page is successfully opened, field 

names will appear in the “Variable (Field) list” list box in the middle of the “Model” 

tab page. If there is no field name or the listings in the list box are insufficient, 

return to the “Data” tab page, then press the “Open” button after selecting a proper 

data file and format/delimiter option.  

 

 

Figure 5.1: Screenshot of the model tab page just after opening a data file 

If you click the field 

title, the rows will be 

sorted by field value. 
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Basic operations: using an example of Gaussian GWR 

 

< Gaussian GWR model > 

It is essential to ensure that appropriate options are selected for your model 

structure and variables in this “Model” tab page. A conventional (Gaussian) 

GWR model is described as 

 
k iikiiki xvuy  ,),(  , 

where iy , ikx , , and i are, respectively, dependent variable, kth independent 

variable, and the Gaussian error at the location i; ( ii vu , ) is the x-y coordinate of 

the ith location; and coefficients ),( iik vu  are varying conditional on the 

location. Usually, the first variable is constant by setting 1,0 ix , after which 

),(0 ii vu  becomes a geographically varying “intercept” term. 

 

 

< Fitting a Gaussian GWR model >  

To fit a Gaussian GWR model, at least three kinds of operations should be 

done: 

 

(1) < variable settings >: By using the “<” and the “>” buttons, select and move 

the appropriate field of dependent variable to the “dependent variable” text 

box. In a similar fashion, move the fields of independent variables to 

“Local” from the variable (field) list.  

 

The item “000 Intercept” is included in the “Local” list box for 

geographically varying terms as a default condition. By moving the 

“intercept” list item to the variable (field) list, the intercept can be fixed as 

zero in the model (no intercept model). However, in most cases, it is 

recommended that “intercept” not be removed from your model. 

 

(2) < coordinate specification >: Similarly, select and move appropriate fields 

from the variable (fields) list to “x coordinate variable” and “y coordinate 

variable”; then select the appropriate coordinate option (either “projected” 

or “spherical”).  

 

“Projected” is typically used for coordinates projected onto an orthogonal 

two-dimensional space, such as UTM coordinates. “Spherical” should be 

selected if x-y coordinates are stored in a Lat-Lon format (decimal degrees). 

The spherical distance is more accurate if the geographic extent of the 

study area is wide (for example, continental scale). However, spherical 

distance calculation is computationally more expensive than Euclidian 



12 

 

distance calculation applied to “Projected” coordinates. For most city and 

regional scale applications, projected coordinates are suitable in terms of 

the balance between accuracy and computational load. 

 

(3) < model type > 

 Select the “Gaussian” option in the model type panel. 

 

 

< Example of Gaussian GWR > 

The following screenshot shows an example of a Gaussian GWR model using 

the Georgia sample data with the following specifications: 

 

0 1

2 3

PctBatch ( , ) ( , )PctRural

( , )PctPov ( , )PctBlack

i i i i i i

i i i i i i i

X Y X Y

X Y X Y

 

  

 

    

where Xi and Yi are projected x-y coordinates in this example. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5.2: Screenshot of the model tab page for a simple Gaussian GWR 

                                 

(1) 

(2) 

(1) 

(2) 

(3) 
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< ID Key option >   

If you have a locational ID field (such as place names or regional codes), you can 

include it for later use in your results. Using this ID key, you can join your 

resulting output files containing local estimates to other tables (such as GIS 

attribute tables). 

 

 

 

 

 

 

 

 

Figure 5.3: ID key option 

 

 

Semiparametric GWR 

 

< Semiparametric GWR > 

A semiparametric Gaussian GWR model is described as 

  
k il illikiiki zxvuy  ,,),(  . 

 

 

where ilz ,  is the lth independent variable with a fixed coefficient l . Thus, the 

model mixes geographically local and global terms. This kind of model has 

several aliases, such as “mixed model” and “partial linear model”. 

 

The intercept term is usually specified as a varying term since other varying 

coefficients often cause a variation in the intercept. However, it is also possible 

to assign the intercept as a fixed term in the interface. 

 

 

< Variable settings for semiparametric models > 

To fit a semiparametric model, most of the operations needed are the same as 

those used in the case of traditional GWR models. One additional thing is to 

specify the global term by moving independent variables for global terms to the 

“Global” box.  

 

Local terms Global terms 
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< Example of semiparametric Gaussian GWR > 

The following equation is an example of a semiparametric Gaussian GWR 

model using the Georgia sample data with the following specifications: 

 

0 1

2 3

1 2

PctBatch ( , ) ( , )PctRural

( , )PctPov ( , )PctBlack

PctEld PctFB

i i i i i i

i i i i i i

i i i

X Y X Y

X Y X Y

 

 

  

 

 

  
 

It should be noted that the coefficients for PctEld and PctFB, γ1 and γ2 ,are both 

geographically invariable, like the coefficients of the conventional regression model. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

             

Figure 5.4: Specifying global terms 
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Extensions of GWR: GWGLM 

 

< GWR for count and binary outcome > 

A Gaussian error term is suitable for modelling numerical responses. However, 

in the case of modelling count or binary (dichotomous) responses, other model 

types of generalised linear modelling, particularly logistic and Poisson 

regression, are quite popular. As a natural extension of GWR, we can 

theoretically derive geographically weighted generalised linear models 

(GWGLM). In GWR4, geographically weighted Poisson regression (GWPR) and 

geographically weighted logistic regression (GWLR) can be fitted for modelling 

count and binary outcome, respectively, with geographically varying coefficients. 

 

< Fitting a GWPR or GWLR > 

To fit a GWPR or GWLR, simply switch the model type option to select 

“Poisson” or “Logistic”.  

 

 

 

 

 

 

Figure 5.5: Model type settings 

 

Semiparametric GWPR and GWLR using both global and local terms can be 

fitted by specifying terms with fixed coefficients, similar to the semiparametric 

Gaussian GWR case. 

 

Geographically weighted Poisson regression (GWPR) 

 

A GWPR model and its semiparametric variant are shown as 

GWPR:      
 ,~ Poisson exp ( , )i i k i i k ik

y N u v x 
  , 

 

Semiparametric GWPR:  , ,~ Poisson exp ( , )i i k i i k i l l ik l
y N u v x z  

    

 

The dependent variable should be an integer that is greater than or equal to 

zero. iN  is the offset variable at the ith location. This term is often the size 

of the population at risk or the expected size of the outcome in spatial 
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epidemiology. In cases where the “offset variable” box is left blank, iN  

becomes 1.0 for all locations.  

 

 

 

 

 

 

 

Figure 5.6: Offset variable box (optional) 

 

Geographically weighted logistic regression (GWLR) 

 

A GWLR model is shown as 

 

,

~ Bernoulli

logit( ) ( , )

i i

i k i i k ik

y p

p u v x  

 

The dependent variable must be 0 or 1. pi is the modelled probability that 

the dependent variable becomes one. Its semiparametric variant is 

described as  

 

 

, ,

~ Bernoulli

logit( ) ( , )

i i

i k i i k i l l ik l

y p

p u v x z      .

 

 

  



17 

 

< Example of semiparametric GWPR > 

The following equation is an example of the semiparametric GWPR model 

using Tokyo mortality sample data with the following specifications: 

 

 

0 1 2

1 2

db2564 ~ Poisson eb2564 exp

( , ) ( , )OCC_TEC ( , )OWNH

POP65 UNEMP

i i i

i i i i i i i i i

i i

X Y X Y X Y



   

 

  

  

 
 . 

where db2564 and eb2564 are the observed and expected size of deaths in 

region i, respectively. Note that eb2564 is the offset variable. The intercept and 

the two coefficients of OCC_TEC and OWNH are geographically varying but 

the other two coefficients of POP65 and UNEMP are fixed in the entire study 

region. The following screenshot shows the settings that fit the aforementioned 

model. 

 

 

Figure 5.7: Screenshot of the model tab page for a semiparametric GWPR 

using Tokyo mortality sample data 

 

 

 

Model type is 

Poisson 

Offset 

variable can 

be used  for a 

Poisson 

model. 

You can mix 

local and 

global terms. 
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Modelling Options 

 

There are several advanced options for GWR model fitting. Check an option in 

the “Options” panel to enable the corresponding additional computation. 

 

 

 

 

 

 

 

Figure 5.8: Modelling options 

 

Standardisation 

 

If this option is checked, all of the independent variables are standardised by 

z-transformation so that each variable has zero mean and one standard 

deviation. It is useful for interpreting estimated coefficients under the same 

metric. In some cases, standardisation makes iterative computation of model 

fitting faster. 

 

Geographical variability test 

< What is this test? > 

Geographical variability for each varying coefficient is tested by model 

comparison. For testing the geographical variability of the kth varying 

coefficient, a model comparison is carried out between the fitted GWR and a 

model in which only the kth coefficient is fixed while other coefficients are kept 

as they are in the fitted GWR model. Let us term the two models original and 

switched GWR model, respectively. If the original GWR is better than the 

compared switched GWR model by a model comparison criterion such as AICc, 

we can judge that the kth coefficient is certainly varying over space. The test 

routine repeats this comparison for each geographically varying coefficient. 

The model comparison indicator used for this test is the same as the one used 

for bandwidth selection (specified in the “Kernel” tab page). The default 

indicator is AICc. In addition, traditional hypothetical test using F statistics 

for Gaussian models and Chi-square statistics for Logistic and Poisson models. 

See Nakaya (2015) for the details. 
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For example, imagine that a simple GWR model with one independent variable 

and intercept is fitted: 

 

(Fitted model: original GWR model) 

iiiiiii xvuvuy   ,110 ),(),(  

To test the geographical variability of ),(0 ii vu  and ),(1 ii vu , we compare 

the following fixed constant and fixed slope models, respectively, with the 

fitted model. 

 

(Fixed constant model: switched GWR model for testing local constant) 

iiiii xvuy   ,110 ),(  

(Fixed slope model: : switched GWR model for testing local slope) 

iiiii xvuy   ,110 ),(  

 

If the fixed slope model outperforms the fitted model, this suggests that the 

coefficient of ),(1 ii vu  significantly varies over space. For a Gaussian model, 

statistics for F test is also shown. The test is applied to each term specified in 

the “Local” list box. 

 

For computational simplicity, the compared models are fitted with the same 

bandwidth as the fitted model. Since the size of the best bandwidth of the 

simpler model with less number of effective parameters tends to be larger than 

that of the larger model, this geographical variability test is likely to be 

conservative (the originally fitted model is likely to outperform the counterpart 

model). However, the difference in bandwidth between the fitted and the 

compared model tends to be small so that this test is effectively useful for 

inspecting the geographical variability in many situations. 

 

< How do I read the result? > 

GWR4 will report on the difference between the original GWR model and the 

switched model in terms of model comparison indicators, if the test option is 

enabled. The result table consists of rows of local terms with a “Diff of 

Criterion” column, which shows the difference in model comparison indicator 

between the original GWR model and the switched GWR model. If the 

switched GWR model attains a statistically better fit, the value of the model 
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comparison indicator is smaller than that of the original GWR model so that 

“Diff of Criterion” becomes a positive value, suggesting no spatial variability in 

the highlighted local term. If the difference of AICc is less than one or two, 

there is no essential difference. Thus in case that the value of “Diff of 

Criterion” is between -2 to +2, the result should be considered as “weak 

support” of the model comparison. When the difference of AICc is larger than 2 

or 4, the judgment of model comparison is more clearly or strongly supported. 

 

 

< Example of geographical variability test > 

Imagine the example case of simple Gaussian GWR: 

 

0 1 2

3 4

PctBatch ( , ) ( , )PctRural ( , )PctEld

( , )PctPov ( , )PctBlack

i i i i i i i i i

i i i i i i i

X Y X Y X Y

X Y X Y

  

  

  

    

The test results is shown as Table 5.1. 

 

 

Table 5.1: Example of geographical variability tests of local coefficients 

************************************************************************* 

 Geographical variability tests of local coefficients 

************************************************************************* 

 Variable             F                  DOF for F test  DIFF of Criterion 

-------------------- ------------------ ---------------- ----------------- 

Intercept                    4.356206    5.136  141.160       -10.201377 

PctRural                     1.513544    5.811  141.160         6.824748 

PctEld                       2.975073    5.851  141.160        -2.777686 

PctPov                       3.551686    4.850  141.160        -5.464125 

PctBlack                     1.835149    4.202  141.160         3.425468 

-------------------- ------------------ ---------------- ----------------- 

Note: positive value of diff-Criterion (AICc, AIC, BIC/MDL or CV) suggests no 

spatial variability in terms of model selection criteria. 

  F test: in case of no spatial variability, the F statistics follows the F 

distribution of DOF for F test. 

 

In the case of Table 5.1, the model comparison was conducted using AICc. It 

should be noted that if the difference of AIC or AICc is greater than two, we 

may consider that the model performance is clearly different. If the 

difference is greater than four, we can consider that the model comparison 

results is strongly supported. Thus, the coefficients of Intercept and PctPov 

are strongly indicated as varying significantly in the table. In addition, the 
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variability of PctEld is also supported. Similarly, we can judge that the 

coefficient of PctRural and PctBlack are not significantly varying. Thus it 

would be better to consider to change these two local terms to global terms. 

 

If F test using the F statistics with two DOFs in the table is significant at a 

certain alpha level, it means that the geographical variability of the term is 

significant at the alpha level. Similar hypothetical test using Chi-square 

test can be done for Logistic and Poisson model (see Nakaya, 2015). 

 

LtoG / GtoL variable selection. 

 

Like the geographical variability test, for each term in the “Local” list box the 

LtoG variable selection routine conducts a series of model comparison tests 

between the originally fitted model and a model in which a varying term has 

been changed to a fixed term with other terms remaining unchanged. Then, if 

the best of the compared model outperforms the original, the term used by the 

compared model is fixed as the result of the first step. Given the condition that 

the term is fixed, a series of model comparisons are successively repeated for 

each of the remaining varying terms. This variable selection from the 

geographically varying terms to the fix ones is repeated until there is no 

candidate of such a term being changed or no improvement is gained by 

changing any term. 

 

Unlike the geographical variability test, bandwidth selection is applied for 

each compared model as specified in the “Kernel” tab page. 

 

If there are varying terms that you do not want changed to fixed terms, you 

may identify them by clicking the terms in the “Local” list box. In other words, 

highlighted terms in the list box are assumed not to be candidates for 

switching from varying to fixed term. 

 

GtoL variable selection is the reverse of LtoG variable selection. In this case, 

each term in the “Global” list box is a candidate for switching from fixed to 

varying term. The same logic of recursive variable selection of term switching 

from fixed to varying term is conducted. 

 

Warning: these variable selection routines may take 

quite a long time to compute. 
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6. Step 3: The Kernel Tab 

 

Figure 6.1: Screenshot of the default kernel tab 

 

< What to do in this tab page>  

In this tab page, a user is required to select the kernel function for 

geographical weighting to estimate local coefficients, its bandwidth size, and 

model selection criteria that are necessary for finding the best bandwidth and 

for comparing it with other modelling results using the same data. The default 

settings on this tab page can be used for most modelling cases. 

 

(1) < kernel function type >: Choose one of the four available options for 

geographical kernel weighting. 

(2) < bandwidth selection method >: Choose one of the three available options 

for bandwidth size selection. A larger bandwidth will estimate 

geographically smoother coefficients for local terms. The “golden section 

search” option can be used to automatically determine the best bandwidth 

size. 

(3) < checking the coordinates ranges (optional) >: This is an optional function. 

If you would like to know the ranges of the x-y coordinates of your data for 

selecting bandwidth sizes, click the “calculate” button. 

(4) < selection criteria >: Choose one of the four available options for model 

comparison criteria, which are mainly used for bandwidth selection.  

 

(1) 

(2) 
(3) 

(4) 
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Possible fixed and adaptive kernel functions for geographical weighting 

 

If you select a fixed kernel, the geographic extent for local model fitting to 

estimate geographically local coefficients is constant over space. On the other 

hand, adaptive kernel changes such a local extent by controlling the k-th 

nearest neighbour distance for each regression location. 

  

Classic options of geographic kernel type for GWR are “Gaussian fixed kernel” 

and “Adaptive bi-square kernel”. Gaussian kernel weight continuously and 

gradually decreases from the centre of the kernel but never reaches zero. 

Gaussian kernel is suitable for fixed kernels since it can avert or mitigate the 

risk of there being no data within a kernel. Bi-square kernel has a clear-cut 

range where kernel weighting is non-zero. It is suitable for when you want to 

clarify local extents for model fitting. In the case of adaptive kernel, the 

number of areas included in the kernel is kept constant so that using bi-square 

kernel is secure. 

 

 

Table 6.1: Four kernel type options available in GWR4 
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Adaptive Gaussian 
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Notes: i is the regression point index; j is the locational index; 

wij is the weight value of observation at location j for estimating the 

coefficient at location i. 

dij is the Euclidean distance between i and j; 

  is a fixed bandwidth size defined by a distance metric measure. 

)(ki  is an adaptive bandwidth size defined as the k th nearest neighbour 

distance. 
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However, you may want to use different combinations of kernel types (fix or 

adaptive) and kernel functions (Gaussian or bi-square). For example, you may 

know that regression points are evenly distributed and using a bi-square 

function is secure even for a fixed kernel option. Or, in the case of GWLR 

where outcome distribution is unbalanced (e.g. a case-control study of a rare 

disease), bi-square kernel is not secure even for adaptive kernel and you may 

want to try Gaussian adaptive kernel as a securer option. 

 

Bandwidth selection routines 

 

< Golden section search > 

To automatically search for the optimal bandwidth size, there are two options; 

golden-section search and interval search. In most cases, it is expected that 

golden-section search will efficiently identify the optimal bandwidth size. You 

can limit the search range for golden-section search by turning on the “Use 

user-defined range” switch. The default lower limit for golden section search is 

set to roughly keep 40 degrees of freedom for local regression fitting. In some 

cases, it is better to set the minimum size for the search range at a large value, 

such as 100 (see Figure 7.1 as an example). If the best bandwidth is estimated 

as either the max or min of the search ranges, GWR4 gives a warning message. 

In such a case, it is recommended that different min and/or max search ranges 

be tried. 

 

 

Figure 6.1: Example of golden section search use with user-defined range 

from 100 to 200 nearest neighbours 

and using an adaptive kernel) 
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For user-defined bandwidth specification, the number should be a distance 

metric (e.g. 15,000 m) without the metric symbol in the case of fixed kernel, 

while the number should be the number of nearest neighbours to be used for 

the local model fitting process in the case of adaptive kernel (e.g., if you input 

35, the 35th nearest neighbour distance is used for each local model fitting). 

 

< Interval search > 

Interval search is a simple exhaustive search using a regular interval size 

bandwidth within a pre-specified range. Compared to the golden section search, 

the interval search is more intuitive and robust.  

 

 

 

Figure 6.2: Example of interval search use from 10,000 to 20,000 m in 1,000 

m steps (10,000, 11,000, 12,000, …, 19,000, 20,000) 

and using a fixed kernel 

 

 

< Single bandwidth > 

The simplest option is a single bandwidth size where you can provide a specific 

number for the bandwidth size.  

 

 

< Warning message of “invalid fit” > 

Occasionally, the variance of prediction is inadequately inflated compared to 

the observed response variable. It may suggest local colinearity problem 

causing unstable prediction. In such a case, the message of “invalid fit” appears 

in interval and single bandwidth selection options. It may be better to use a 
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large bandwidth without the message to avoid the unstable prediction. It is 

important to note that the interval search ignore invalid fits to find the option 

bandwidth size. But the golden section search may lead to an invalid fit as the 

option with a warning message of “(Warning: trace(S) is smaller than 

trace(S'S). It means the variance of the predictions is inadequately inflated.)” 

 

<Warning message of “lower limit is selected”> 

In case of golden section search and interval search options, the optimal 

bandwidth size is found as the lower limit of the search. In that case, the 

warning message of “The lower limit in your search has been selected as the 

optimal bandwidth size” appears in the output. In such a case, it is 

recommended to use a smaller lowest limit of the bandwidth search and retry 

bandwidth selection. 

 

Selection criteria 

 

In the golden section and interval searches, the optimal bandwidth size is 

determined by means of comparison of model selection indicators with different 

bandwidth sizes. The criterion is also used for several modelling options 

described previously. 

 

< AICc and AIC > 

The default option is AICc (small sample bias corrected AIC) which is the most 

suitable in terms of statistical prediction for local Gaussian regression 

modelling where the local degree of freedom is likely to be small. Classic AIC 

tends to choose smaller bandwidths by which geographically varying 

coefficients are likely to be undersmoothed. The bias correction for Poisson and 

logistic models by AICc is not theoretically justified. However, AICc empirically 

provides better results even for Poisson regression.  

 

< BIC/MDL and CV > 

BIC/MDL is a new option that tends to choose larger bandwidth sizes. The 

indicator is appropriate for arguing the degree of complexity of the process to be 

analysed rather than statistical prediction of unobserved outcomes. Another 

classic but robust indicator, cross validation (CV) is applicable only to Gaussian 

models.  
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7. Step 4: The Output Tab 

Session Control File 

 

A user should input the name of your session control file in the top red-coloured 

textbox by clicking the rightmost “Browse” button to open a file dialog box. All of 

your settings, including filenames, model specifications, and modelling options 

will be saved in this simple text-formatted file when the session is run or the 

“save session” command in the File menu is issued.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7.1: Sample screenshot of “Step 4: Output” 

 

You may also save the current setting, open a stored session control file, or 

initialise the current setting at any time by using the File menu, as outlined below: 

 

“New session” initialises the current session. Every 

setting reverts to its default. 

“Open session” opens an existing session file (*.ctl 

file). 

“Save session” creates a text file with a .ctl 

extension. 

As default, the box is 

checked. Under this 

condition, once the 

session control file is 

specified, other two 

common outputs are 

automatically 

assigned. 
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Common output files 

 

In all cases, the modelling result is summarised in “Summary file” which is a 

plain-text file, and “Geographically listwise file” which lists estimated local 

statistics, including geographically varying coefficients and local diagnostic 

indicators, is saved in a CSV file. As default, the two common outputs are 

automatically assigned with the filenames and filepaths which the session 

control file is currently using. If the box of “Use the session control filename …” 

is unchecked, you can provide other filenames and filepaths for the two common 

output files. 

 

The “Prediction at non-regression points” option 

 

When this box is checked, you can provide a list of x-y coordinates for 

estimating local geographical coefficients and local goodness-of-fit indicators. 

This can be used for displaying a gridded surface of geographically varying 

coefficients or diagnosis of cross-validation design. 

 

 

 

Figure 7.2: Sample screenshot of “Step 4: Output” when “Prediction at non-

regression points” is turned on. 
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A prediction point definition file must be a text file in which each row contains 

x and y coordinates, and assumes that the first column lists x coordinates and 

the second column lists y coordinates. The first row is assumed to be used for 

field name listing. Any delimiter of space, comma, and tab can be used and 

there is no need to specify which delimiter is used. A sample is given below. 

 

       Table 7.1: Sample data of prediction point definition file 

 

 

 

 

 

 

  The output file is automatically formatted as a CSV, comma delimited, text file. 

8. Step 5: The Execute Tab 

The Execute button 

 

When you are ready to execute the session to fit your GWR model, click the 

“Execute this session” button to begin the model fitting computation. Running 

status information will appear during the computation but it may proceed 

slightly slowly.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 8.1: Sample screenshot of “Step 5: Execute” 
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When the computation ends, a results-summary appears in the large textbox. 

The content includes your modelling settings, global model result, best 

bandwidth, model diagnostic information of the GWR model, and fixed 

coefficients if you used them for the fitted model. These are automatically saved 

in the summary output file specified in the previous tab page. 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 8.2: Sample screenshot of the output when model fitting ends 

 

 

In addition, the “View geographically listwise result” button is now enabled. 

When you click it, a gridded window appears to show geographically listwise 

information, including local estimates of coefficients and model diagnostic 

information, in a tabular format. The information is stored in the CSV file of 

the geographically listwise result specified in the previous tab page. 

 



31 

 

Fields in a listwise output 

 

The fields in a listwise table are as follows: 

 

---------------------------------------from here-------------------------------------------------- 

Area_num: the sequential ID number of the location (automatically assigned), 

Areal_key: if you selected this in the model tab, the field will be included. 

x_coord: x coordinate of the regression points (data observations) 

y_coord: y coordinate of the regression points (data observations) 

est_intercept: estimate of the local constant term 

se_intercept: standard error of the local constant term 

t_intercept: pseudo t value (estimate / standard error) of the local constant 

term 

#loop for each independent variable with geographically varying coefficient 

{ 

       est_variablename: local estimate of coefficient 

       se_variablename: local standard error 

       t_variablename: local pseudo t value 

   } 

 #loop end 

 y: observed value of the dependent variable 

 yhat: predicted dependent variable 

 residual: y – yhat 

 std_residual: studentised residual 

 localR2: local R square 

 influence: influence indicator 

 cooksD: Cook’s D indicator 

 

---------------------------------------end-------------------------------------------------- 

 

In the case of GWGLM, std_residual, localR2, and cooksD are not included, 

while local pdev (local percent deviance explained) and Ginfluence are 

included. Local pdev is a measure of the local goodness-of-fitness defined as 

below: 

iii nulldevdevpdev /1  

where devi is the locally weighted deviance of the fitted model and nulldevi is the 

locally weighted deviance of the null model having only a constant term at 

location i. Pdev is also known as a type of pseudo R square. The higher the 

value is, the better the model fits to the data. In the case of Pdev = 1, the model 
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predictions are equal to the observed ones. Ginfluence is an influence indicator 

which is currently used for a developer’s purpose. 

 

When you turn on the “prediction at non-regression points” switch in the 

Output tab page, another button, “View prediction at non-regression points” is 

enabled. Clicking the button will open another spreadsheet-like window. The 

field information is the same as that stored in the prediction output file but the 

values are coefficients or local diagnostic indicators at non-regression points 

provided in the “Output” tab page. 

 

 

 

Figure 8.3: Sample screenshot of the output when model fitting ends 

for a case where the “prediction at non-regression” switch was turned on. 

 

Handling a session and batch mode (optional) 

 

By using the graphical user interface (GUI) based interface, the necessary 

settings can be assigned interactively. A session control setting is automatically 

saved when the session is run by clicking the “Execute this session” button. 

Alternatively, you can save the control file at any time by selecting “Save 

session” in the File menu. The session file is also be used in this application’s 

batch mode. Open a command prompt and then type “sgwrwin” plus the desired 
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session filename. The application will then carry out the computations 

necessary to calibrate the model described in the session file without using the 

GUI. 

 

The full path to sgwrwin.exe is needed in order for the program to be executed 

via the command prompt. 

 

 

e.g. > “C:/Program Files (x86)GWR4/sgwrwin” mysession.ctl 

(Note: “>” is the command prompt.) 

 

 

If the GWR4 install folder is included in the PATH environment variable, you 

can omit the install folder for the execution at the command prompt. 

 

 

e.g.   > set path=%path%;”c:¥program files¥GWR4” 

       > sgwrwin mysession.ctl 

 

 

The easiest way to create such a batch file is to use the interface of the Execute 

tab. With the “Execute by a batch file” box checked, you can specify the path 

and name of the batch file. Then, by clicking the “Execute this session” button, 

you can create the batch file and then choose to execute it immediately or at a 

later time. 

 

 

 

 

 

 

 

 

Figure 8.4: Sample screenshot of the process to create a batch file.  

 

Example output 

 

Imagine an example of Gaussian GWR with three local terms and two global terms 

using the Georgia data sample: 
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0 1 2
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  

  

  
 . 

When the model is fit with the geographical variability test, the adaptive kernel 

function, the golden section search for finding the optimal bandwidth size, and 

AICc as the model indicator for selecting the optimal bandwidth, the output file 

will resemble the one below: 

 
------------------------------from here--------------------------------------- 

***************************************************************************** 

*             Semiparametric Geographically Weighted Regression              

*                         Release 1.0.90 (GWR 4.0.90)                        

*                               12 May 2015                                  

*                 (Originally coded by T. Nakaya: 1 Nov 2009)                

*                                                                            

*              Tomoki Nakaya(1), Martin Charlton(2), Chris Brunsdon (2)      

*              Paul Lewis (2), Jing Yao (3), A Stewart Fotheringham (4)      

*                       (c) GWR4 development team                            

* (1) Ritsumeikan University, (2) National University of Ireland, Maynooth,  

*         (3) University of Glasgow, (4) Arizona State University            

***************************************************************************** 

 

Program began at 2015/03/12 15:48:36 

 

***************************************************************************** 

Session: Gaussian semiparametric model using Georgia data 

Session control file: C:¥ProgramData¥GWR4¥georgia.ctl 

***************************************************************************** 

Data filename: C:¥ProgramData¥GWR4¥GeorgiaEduc.txt 

Number of areas/points: 174 

 

Model settings--------------------------------- 

Model type: Gaussian  

Geographic kernel: adaptive bi-square 

Method for optimal bandwidth search: Golden section search 

Criterion for optimal bandwidth: AICc 

Number of varying coefficients: 3 

Number of fixed coefficients:   2 

 

 

The session title and 

control file specified in the 

Data tab 

The data file and the 

number of records 

(areas/points) 

The “Model settings” 

section reflects your 

specification of GWR 

model in the Model tab 

page. 

Three local terms and two global 

terms are used. 
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Modelling options--------------------------------- 

Standardisation of independent variables: OFF 

Testing geographical variability of local coefficients: On 

Local to Global Variable selection: OFF 

Global to Local Variable selection: OFF  

Prediction at non-regression points: OFF 

 

Variable settings--------------------------------- 

Area key: field22: ID 

Easting (x-coord): field23 : X 

Northing (y-coord): field24: Y 

Cartesian coordinates: Euclidean distance 

Dependent variable: field17: PctBach 

Offset variable is not specified 

Intercept: varying (Local) intercept 

Independent variable with varying (Local) coefficient: field18: PctEld 

Independent variable with varying (Local) coefficient: field20: PctPov 

Independent variable with fixed (Global) coefficient: field16: PctRural 

Independent variable with fixed (Global) coefficient: field21: PctBlack 

***************************************************************************** 

 

***************************************************************************** 

  Global regression result 

***************************************************************************** 

  < Diagnostic information > 

Residual sum of squares:                 2665.660247 

Number of parameters:                        5 

 (Note: this num does not include an error variance term for a Gaussian model) 

ML based global sigma estimate:             3.914063 

Unbiased global sigma estimate:             3.971541 

-2 log-likelihood:                        968.663015 

Classic AIC:                              980.663015  

AICc:                                     981.166009 

BIC/MDL:                                  999.617346 

CV:                                        16.904655 

R square:                                   0.500354 

Adjusted R square:                          0.485484 

 

Variable                  Estimate    Standard Error      t(Est/SE)  

-------------------- --------------- --------------- --------------- 

Intercept                  24.762724        1.269480       19.506195 

Advanced options in the 

Model tab page 

“Variable settings” 

summarises which fields of 

your data are assigned for 

GWR variables. 

Model fitting result of the 

traditional global regression 

model 
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PctEld                     -0.180800        0.131507       -1.374834 

PctPov                     -0.294314        0.074928       -3.927979 

PctRural                   -0.104574        0.012737       -8.209968 

PctBlack                    0.050891        0.027491        1.851218 

 

***************************************************************************** 

  GWR (Geographically weighted regression) bandwidth selection 

***************************************************************************** 

 

Bandwidth search <golden section search> 

  Limits: 45,  60  

 Golden section search begins... 

 Initial values 

  pL            Bandwidth:    45.000 Criterion:    957.506 

  p1            Bandwidth:    47.188 Criterion:    957.155 

  p2            Bandwidth:    48.541 Criterion:    958.331 

  pU            Bandwidth:    50.729 Criterion:    958.940 

 iter    1 (p1) Bandwidth:    47.188 Criterion:    957.155 Diff:      1.353 

 iter    2 (p1) Bandwidth:    46.353 Criterion:    957.100 Diff:      0.836 

 iter    3 (p2) Bandwidth:    46.353 Criterion:    957.100 Diff:      0.517 

Best bandwidth size 46.000  

Minimum AICc      957.100 

 

***************************************************************************** 

  GWR (Geographically weighted regression) result 

***************************************************************************** 

  Bandwidth and geographic ranges 

Bandwidth size:                   46.352549 

Coordinate                Min              Max           Range 

--------------- --------------- --------------- --------------- 

X-coord           635964.300000  1059706.000000   423741.700000 

Y-coord          3401148.000000  3872640.000000   471492.000000 

 

  Diagnostic information  

Residual sum of squares:          1648.136749 

Effective number of parameters (model: trace(S)):                    28.690376 

Effective number of parameters (variance: trace(S'S)):               22.092235 

Degree of freedom (model: n - trace(S)):                            145.309624 

Degree of freedom (residual: n - 2trace(S) + trace(S'S)):           138.711483 

ML based sigma estimate:             3.077670 

Unbiased sigma estimate:             3.446993 

If golden section search is selected, 

the iterative steps to identify the 

optimal bandwidth size are reported.  

In this example, the search range is 

user-defined between 45th and 60th 

nearest neighbours. 

For each step, the current best 

bandwidth size and model 

comparison indicator, and the 

difference in bandwidth size 

for the current and previous 

iterative steps are reported. 

The ranges of the geographic 

coordinates of sample 

observations are reported. 
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-2 log-likelihood:                 885.002707 

Classic AIC:                       944.383458 

AICc:                              957.100103  

BIC/MDL:                          1038.176997 

CV:                                 17.283949 

R square:                            0.691077 

Adjusted R square:                   0.611915 

 

*********************************************************** 

 << Fixed (Global) coefficients >> 

*********************************************************** 

 Variable             Estimate        Standard Error  t(Estimate/SE) 

-------------------- --------------- --------------- --------------- 

PctRural                   -0.119099        0.019274       -6.179277 

PctBlack                    0.053770        0.058020        0.926748 

 

 

 

*********************************************************** 

 << Geographically varying (Local) coefficients >> 

*********************************************************** 

Estimates of varying coefficients have been saved in the following file. 

    Listwise output file: C:¥ProgramData¥GWR4¥georgia_listwise.csv 

 

Summary statistics for varying (Local) coefficients  

Variable                      Mean             STD  

-------------------- --------------- --------------- 

Intercept                  25.153533        5.998001  

PctEld                     -0.379015        0.521673 

PctPov                     -0.163421        0.202621 

 

Variable                       Min              Max           Range 

-------------------- --------------- --------------- --------------- 

Intercept                  13.169631       40.843200       27.673569 

PctEld                     -2.371389        0.253782        2.625171 

PctPov                     -0.666584        0.391195        1.057780 

 

Variable               Lwr Quartile          Median    Upr Quartile 

-------------------- --------------- --------------- --------------- 

Intercept                  20.966427       24.311530       28.994175 

PctEld                     -0.597261       -0.197528       -0.028855 

Model diagnostic indicators of the 

fitted GWR model. For example, 

AICc of GWR  (957.1) is clearly 

smaller than that of the global 

regression model (981.1). 

If you specify global terms in the 

Model tab page, estimates of global 

term coefficients are tabulated. 

Estimates and local diagnostic 

indicators are stored in the CSV file.  

Summary statistics of 

estimated coefficients 

of local terms  
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PctPov                     -0.289575       -0.181102       -0.048002 

 

Variable             Interquartile R     Robust STD 

-------------------- --------------- --------------- 

Intercept                   8.027748        5.950888 

PctEld                      0.568406        0.421354 

PctPov                      0.241573        0.179076 

 (Note: Robust STD is given by (interquartile range / 1.349) ) 

 

 

 

***************************************************************************** 

 GWR ANOVA Table 

***************************************************************************** 

Source                           SS          DF             MS           F 

----------------- ------------------- ---------- --------------- ---------- 

Global Residuals              2665.660    169.000 

GWR Improvement               1017.523     30.289          33.594 

GWR Residuals                 1648.137    138.711          11.882   2.827389 

 

 

 

 

 

************************************************************************* 

 Geographical variability tests of local coefficients 

************************************************************************* 

 Variable             F                  DOF for F test  DIFF of Criterion 

-------------------- ------------------ ---------------- ----------------- 

Intercept                    4.859271    7.105  145.310       -17.247067 

PctEld                       6.353373    8.043  145.310       -30.108726 

PctPov                       2.926430    7.201  145.310        -3.464930 

-------------------- ------------------ ---------------- ----------------- 

Note: positive value of diff-Criterion (AICc, AIC, BIC/MDL or CV) suggests no 

spatial variability in terms of model selection criteria. 

  F test: in case of no spatial variability, the F statistics follows the F 

distribution of DOF for F test. 

***************************************************************************** 

Program terminated at 2015/03/12 15:48:36 

 

------------------------------  end  ---------------------------------------- 

Using GWR ANOVA, a simple test to 

find out if the global (traditional) 

regression model and the GWR model 

have the same statistical performance 

(the same size of error variance) can be 

carried out. 

If you select the option for geographical variability test in the 

Model tab page, the tabulated report shows the test results. 

A positive “DIFF of Criterion”, especially greater than or 

equal to two, suggests that the local term is better to be 

assumed as global. 
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Most of the theories underlying GWR and the definition of diagnostic indicators are 

explained in Fotheringham et al. (2002), except for the details of backfitting 

semiparametric modelling in this software, which is different from that explained 
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disease associative mapping (Nakaya et al., 2005). 
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Compared to the previous version (GWR3.x), GWR4 provides almost same results 

for traditional GWR modelling. A few corrections have been made with regards to 

calculation methods for local diagnostic statistics, including local sigma and local R 

square. 


